
 Introduction
Pink Mouse’s Image Organiser (PMIO V1.2) is a powerful and flexible tool for organising and viewing 
your image files. You can use it to view, copy, move, rename, delete and comment your images. You can 
also use it to automatically generate HTML documents for use on the World Wide Web. The program 
features multiple Browser Windows, an Animation Window for checking animation effects, and an Image 
Basket for gathering images to work on while browsing.



System Requirements
The program was written and tested on a Windows 95 Pentium system, but it fails to run correctly on 
Windows NT. Therefore this release of the program is for Windows 95/98 only. It requires at least 16MB 
of RAM and at least 256 colours to run properly. Note, however, that it was designed and optimised to 
run on a 16-bit or better display. 256 colour mode is not recommended because it is slower and doesn’t 
look as good. On the subject of colours, the pictures in this help document are only 256-colours or less, 
and do not represent the quality of the actual display.



Supported File Formats
This version of the program only supports BMP and JPEG images. Support for further image files will be 
added if there is sufficient interest in the development of the program. GIF support will unfortunately not 
be included because it requires a license from Unisys which I don’t have the time, inclination or funds to 
pursue.



License and Disclaimer
This program and all files that accompany it are freeware which means that you are free to use, copy 
and distribute the software and encourage its use. Please do not modify any of the files yourself - you 
should only distribute the original zip file.

This software is provided as is with no warranties either express or implied as to its suitablility 
for use on any computer system. The author cannot be held responsible for any problems caused
directly or indirectly by the use of this software. You use this software entirely at your own risk. 

Or, in plain English: While every care has been taken to ensure that this software reaches you in perfect 
condition, you may find that the contents have settled during transit. If anything goes wrong, it’s not my 
fault.



Credits 
Pink Mouse Productions presents Pink Mouse’s Image Organiser V1.2. This program was written by 
John Croudy. It was mainly tested by Satu Ilva who also made many suggestions and wrote a set of 
Word macros to enable easier creation of this help file. I would also like to thank all the other people who 
downloaded and tested the beta versions of this program. Thanks also to all those who have e-mailed 
me with suggestions, most of which have been implemented in this release. This version of PMIO has a 
slightly different splash screen and thumbnail size picture. The original was taken from a print of John 
William Waterhouse’s wonderful painting ‘The Lady of Shalott’. I was under the impression that since the 
artist has been dead for over 50 years, I could use the picture. It turns out that this is not necessarily true.
In order to prevent any problems, I unhappily decided to remove the image completely. The replacement 
was digitally created from various photos taken by myself. All images in this program were taken using an
Olympus C-1000 digital camera, and processed using Paint Shop Pro 5.



About John
John Croudy <106547.3403@compuserve.com> is the author of PMIO and other Pink Mouse 
Productions software. He is currently living with his girlfriend in Turku, Finland. His favourite pastimes are
programming, watching films, observing astronomical bodies, and eating spicy food that does not contain
bits of animal’s bodies. For more information on this strange person, go to:

http://ourworld.compuserve.com/homepages/sprucetree/



 About Satu
Satu Ilva <sailva@utu.fi> is the author’s girlfriend and software tester. She had a large part in the 
design of this program, and has made many suggestions for improvement. Her favourite pastime is 
telling me that some caption or other doesn’t fit when using Large Fonts. For more information on this 
wonderful human being, go to:

http://www.utu.fi/~sailva



 About the Pink Mice
If you really want to know what these pink mice are, go to:

http://www.geocities.com/CapeCanaveral/9725/



Getting Started
When you start the program, it displays the main Browser Window. This window contains an Explorer-
style Folder Browser for navigating folders, a Shortcut List below it, and a Thumbnail Panel to the right. It 
also contains the menus and tool bars. The program remembers the last folder that this browser was 
using and automatically opens it. If the folder already has a browse file, it will be loaded; otherwise the 
folder will be scanned and each image will be loaded as a thumbnail. When this is complete you can 
save the browse file manually or allow the program to auto-save it, depending on preference settings. 
Click here for a visual tour of the program.



The Browser Window
The Browser Window is the most often used window in PMIO. From here you can perform most 
operations on your image files. Click on the picture below for information on each object or tool.

The Browser Window



 Up One Level
This command provides a quick way of navigating to the parent folder.



 Open Folder
This command displays a folder browser which you can use to navigate to a folder. This folder will then 
be opened in the thumbnail panel in the usual way. The advantages of this over the normal Folder 
Browser are that firstly, the thumbnail panel doesn’t keep opening and closing folders while you navigate,
and secondly, this window can be resized independently of the thumbnail browser.



 Save Browse File
This command saves the currently selected thumbnails in a browse file. The command is only enabled if 
there is something to save, that is, if the thumbnails have been modified since they were last saved. If the
auto-save preference is enabled, you will not usually need to use this command.



 Thumbnail Wizard
The Thumbnail Wizard allows you to generate a set of JPEG files and an optional HTML document to 
accompany them. This allows easy creation of pages suitable for use on the World Wide Web. The 
wizard itself contains all the information you need to use it, so it will not be described in detail here. The 
label format specifiers used on page 3 of the wizard are described here.
Please read the section on thumbnail quality before using this function.



Thumbnail Label Format Specifiers
The following case-insensitive format specifiers can be used when labelling thumbnails. They can all be 
used on page 3 of the HTML wizard. In General Preferences you can only use the specifiers shown in 
black.

%f The name of the image file.
%s The size of the image file.
%p The pixel size of the image.
%b The bit-depth of the image.
%d The date stamp of the image file
%m The image memo text.
%n The sequence number of this image on the HTML page.
%t The total number of images on the HTML page.

As an example, consider the following format:

File %n of %t, Name: %f, Size: %p (%b-bit, %s), Memo: %m

This could generate the following output:

File 9 of 20, Name: Camelot.jpg, Size: 800 x 600 (24-bit, 94KB), Memo:
Scanned from an old painting.



 Export Image Memos
This command exports the memos of all the selected images into a set of text files with similar names to 
the images. For example, an image called Image.jpg will generate a text file called Image.txt. If the 
image does not have a memo associated with it, no file is created. Any previously existing files by the 
same name are overwritten with no prompting.



 Preferences
This command opens the Preferences Window where you can set your preferences regarding the 
operation of various parts of the program.



 Open
This command opens the currently selected image(s). The effect of this depends on the first entry in the 
application list. It may also ask you to confirm that you want to open the images, depending on the 
current preference settings.



Open With
This menu item brings up a sub-menu which allows you to choose which application you want to open 
the currently selected image(s) with. This sub-menu can be customised by modifying the application list.



 Cut
This command cuts the selected images to the clipboard. This means that the images will become drop 
highlighted (faded) and ready to be pasted into another folder. If the paste operation is performed, the 
corresponding image files will be moved to the destination folder.



 Copy
This command copies the selected images to the clipboard. This means that the images will become 
ready to be pasted into another folder. If the paste operation is performed, the corresponding image files 
will be copied to the destination folder.



 Paste
This command will paste the contents of the clipboard to the destination folder. This means that the 
images that were previously cut or copied to the clipboard will be moved or copied to the destination, 
respectively.



 Delete
This command will delete the selected images by moving them to the recycle bin. Note that the operation
of the recycle bin depends on your Explorer settings. You can undo the delete operation and recover the 
images by using the Undo command in any Explorer window. In this case, you will need to Update the 
thumbnail panel. See External Operations. Depending on Preference settings, you may be presented 
with the Delete Confimation Window.



 Rename
This command brings up the Rename Window which allows you to rename the selected images.



 Copy To
This command brings up the Copy To Window, which allows you to copy the selected images to another 
folder.



 Move To
This command brings up the Move To Window, which allows you to move the selected images to another
folder.



 Select All
This command selects all the images in the current folder (or basket). 



 Select None
This command unselects all the images in the current folder (or basket).



 Invert Selection
This command inverts the selection state of all the images in the current folder (or basket). This means 
that all previously selected images become unselected, and all previously unselected images become 
selected. This is useful when you want to select all but a few images. Simply select the ones you don’t 
want and then invert the selection.



 Add To Basket
This command adds the currently selected images to the image basket.



 Animate Selection
This command sets the currently selected thumbnails as the animation in the animation window, shows 
the animation window, and begins playback of the animation.



Ping-Pong Selection
This command sets the currently selected thumbnails as the animation in the animation window, shows 
the animation window, and begins playback of the animation. It differs from the Animate Selection 
command in that it adds the thumbnails in a special ‘ping-pong’ sequence. For example, if four 
thumbnails are selected, they will be added in the sequence 1 - 2 - 3 - 4 - 3 - 2. This allows quick 
checking of animations that repeat forwards and backwards.



 Properties
This command displays the Properties Window for each of the selected images in turn.



 New Browser
This command opens a new browser window which you can then use to create and view thumbnails of 
images in a different folder. You can open as many browser windows as you want, limited only by the 
available computer resources. One use for multiple browsers is dragging and dropping thumbnails 
between browsers to move images. Another use is for creating thumbnails in the background. Because 
creation of thumbnails can take a long time for large folders, you can open a new browser and let it 
create thumbnails in the background while you work on a different folder in the original browser. If you 
have many folders with many images in them, you can open a number of browsers, navigate them to 
different folders, and leave the computer to create thumbnails while you are away. Be aware that this 
kind of operation takes a lot of computing power and a lot of memory.



 Toggle Basket Window
This command toggles the display of the Basket Window on and off.



 Toggle Animation Window
This command toggles the display of the Animation Window on and off.



 Toggle Image Finder
This command toggles the display of the Image Finder on and off.



 Update Thumbnails
This command updates the thumbnail panel. The current folder is scanned and any new images are 
loaded and added to the thumbnail panel. Any images that have been deleted are removed from the 
thumbnail panel, and any images that have been modified are reloaded so that the thumbnail reflects the 
changes. This command should be used whenever a folder has been modified externally to PMIO. If the 
auto-update preference is enabled, this command is automatically executed when a folder is opened.



 Re-Lay Thumbnails
This command re-lays the thumbnails on the thumbnail panel so that they fit the width of the panel. If the 
auto re-lay preference is enabled, this command is automatically executed whenever the browser 
window is resized.



Reload Thumbnails
This command reloads the thumbnails on the thumbnail panel. It displays a confirmation request telling 
you how long these thumbnails previously took to load, and giving you a chance to cancel the operation.



Load Now
This command forces the selected thumbnails to be loaded. If you have opened a folder with many 
images, and you are interested in some images that are not yet loaded, you can either wait for the 
program to get to them, or you can select them and use Load Now to force the program to load them as 
soon as possible.



Set As Wallpaper
This command sets the selected image as the system wallpaper. There are two sub-commands for this:

Image Sets the actual full-sized image as the wallpaper.

Thumbnail Sets the thumbnail image as the wallpaper.



Show As Image
This command causes the thumbnail panel to display the thumbnails as images. This is the normal 
default operation. Selecting this option switches off the Show As Text option.



Show As Text
This command causes the thumbnail panel to display the thumbnails as text instead of pictures. 
Selecting this option switches off the Show As Image option.



Show Toolbar 1
This command toggles the display of toolbar 1



Show Toolbar 2
This command toggles the display of toolbar 2



Close Browser
This command closes the browser it was issued from. If this is the last browser and there are no other 
PMIO windows open, this will also exit from the program.



Delete Browse File
This command deletes the browse file for the current folder. It is useful for removing browse files from 
your disk when you are no longer interested in browsing that folder.



Close All and Exit
This command closes all PMIO windows and exits from the program.



 Browser Window Help
This command displays help on the Browser Window (ie: this help page).



Contents
This command displays Windows Help for PMIO.



 About
This displays a window showing information about the program, including version number and contact 
information. Please feel free to send an e-mail to the author if you have any comments or bug reports.



System Info
This command shows the standard operating-system information window.



 Folder Browser
The Folder Browser is used to navigate to the folder you wish to browse. It works in the same way as the 
Explorer tree view (left panel). When a folder is selected it is immediately opened in the thumbnail panel. 
This may result in the previous folder’s browse file being saved, depending on preference settings.



Folder Edit Box
This edit box provides a way of navigating to a folder by entering it as text. You can also paste in a folder 
name from the clipboard. If you enter a non-existent folder name, the edit box will turn red. When you use
the Folder Browser to navigate to a folder, this edit box is automatically updated.



 Shortcut List
This is a list of shortcuts to folders. For more information see About Shortcuts



Thumbnail Panel
The thumbnail panel is the area of the browser where thumbnails are displayed. You can select 
thumbnails on the panel, drag them to the Folder Browser, Shortcut List, Animation Window, or Basket 
Window, or the thumbnail panel on another browser. You can also arrange the thumbnails manually by 
dragging them within the same thumbnail panel. To do this, you must drag the thumbnails to one of the 
vertical bars between any two thumbnails.



Horizontal Splitter
The horizontal splitter can be dragged to change the width of the Folder Browser and Shortcut List.



Vertical Splitter
The vertical splitter can be dragged to change the relative heights of the Folder Browser and Shortcut 
List.



Status Panel
The status panel shows information about what the program is doing, as well as information about the 
folder that is currently open in the thumbnail panel.



Progress Panel
The progress panel shows the progress of loading and saving operations.



 Frame Back
Goes back to the previous frame of the animation



 Frame Advance
Advances to the next frame of the animation



 Reverse Play
Starts the animation playing in reverse. If the Loop option is checked, the animation will automatically 
repeat from the end when it reaches the start.



 Stop
Stops the animation playback.



 Play
Starts the animation playing. If the Loop option is checked, the animation will automatically repeat from 
the start when it reaches the end.



 Open Image
Opens the image corresponding to the current frame. The effect of this depends on the first entry in the 
application list.



 Remove Frame
This command removes the current frame from the animation.



 Remove All
This command removes all the frames from the animation. It asks ‘Are you sure?’ before doing so.



Loop
If the Loop option is checked, the animation playback will automatically loop back to the start when it 
finishes. Otherwise, the playback will stop.



Current Frame
The current animation frame is displayed here. The size of the frame depends on the size of the 
corresponding thumbnail.



Speed
This slider controls the speed of the animation playback.



Frame Number
This is the frame number of the current frame within the animation sequence.



Image Dimensions
This shows the dimensions of the image (not the thumbnail) corresponding to the current frame.



Image Name
This is the file name of the image corresponding to the current frame.



 The Basket Window
The Basket Window is a useful tool for storing references to images temporarily while browsing in more 
than one folder. The name ‘basket’ comes from the analogy with supermarket shopping. While browsing 
the different shelves (folders) you choose items (images) that you want to buy (process). You can drag 
and drop files from Windows Explorer onto the basket window and have them entered into the basket, or 
you can drag thumbnails to the basket from any browser window. Most of the basket commands are 
available from a context-menu and the toolbar. The new command Open Browser is only available from 
the context-menu. It allows you to select some images and open browsers for the folders that those 
images are located in. Click on the picture below to get information on each item.

The Basket Window



 The Animation Window
The Animation Window allows you to animate a sequence of thumbnail images. Its primary use is for 
quickly checking that a set of thumbnails are suitable for animating before going to the trouble of loading 
the images into an animation software package. You can select one or more thumbnails and drag them to
the animation window where they will be added to the animation. You can use the Animate Selection or 
Ping-Pong Selection commands to set the selected thumbnails as the current animation. You can use the
various toolbar controls to play, stop and step through the animation. You can remove frames from the 
animation or open the image represented by the currently displayed frame. Click on the picture below to 
get information on each item.

The Animation Window



 The Delete Confirmation Window
This window gives you extra protection from accidental deletes. If you already have the Explorer’s ‘delete
confirmation dialog’ enabled then you will probably want to disable this window. This can be done in 
preferences or by checking the ‘Don’t show me this again’ option on the window itself. Click on the 
picture below to get information on each item.

The Delete Confirmation Window



Don’t show me this again
Checking this option disables the Delete Confirmation Window. You can enable it again from 
Preferences.



 The Rename Window
Click on the picture below to get information on each item.

The Rename Window



 The Copy To Window
This window is displayed in response to the Copy To command. Click on the picture below to get 
information on each item.

The Copy To Window



 The Move To Window
This window is displayed in response to the Move To command. Click on the picture below to get 
information on each item.

The Move To Window



 The Properties Window
Click on the picture below to get information on each item.

The Properties Window



 The Image Finder
The image finder allows you to search for images in all browsers and the basket. Click on the picture 
below to get information on each item.

The Image Finder



The Search Pattern
Enter the search pattern in this edit box. The last 10 search patterns are remembered in the drop-down 
list. A search pattern is a file name or part of a file name. If the Exact Match option is checked, the search
pattern must be the exact file name that you want to find. Otherwise it can be part of a file name, and any
image whose file name contains the search pattern will be matched. Do not enter wildcards (*) because 
they are not recognised and you will get no matches at all. When an image is matched in a browser or 
the basket, it is selected and scrolled into view.



Match case
If this option is checked, the search will be case-sensitive.



Exact match
If this option is checked, the search will only find images that exactly match the search pattern.



Include basket in search
If this option is checked, the basket will also be searched



Clear selection before searching
If this option is checked, the current selection will be cleared before searching in each browser or the 
basket.



The Search Result
The search result is displayed here. For example, No matches or 23 matches. This is the total number 
of matches across all browsers and the basket (if included).



 The Preferences Window - General Tab
Click on the picture below to get information on each item.

The Preferences Window



 The Preferences Window - Folder Tab
Click on the picture below to get information on each item.

The Preferences Window



 The Preferences Window - JPEG Tab
Click on the picture below to get information on each item.

The Preferences Window



 The Preferences Window - Applications Tab
Click on the picture below to get information on each item.

The Preferences Window



 Large Icons
Displays the items by using large icons.



 Small Icons
Displays the items by using small icons.



 List
Displays the items in a list.



 Details
Displays information about each item in the list.



Sort Headers
Click on these headers to sort the displayed information.



Basket Information
This area shows information about the images in the basket.



Basket Icons
These icons show the status of the images. If the image is loaded as a thumbnail in any browser, the icon
is dark brown ( ), otherwise it is a faded blue colour (

 ).



 Remove From Basket
This command removes the selected images from the basket. It does not delete or affect the images in 
any way.



 Remove All
This command removes all of the images from the basket. It does not delete or affect the images in any 
way.



Rename Button
Renames the image and closes the window.



Delete Button
Deletes the image and closes the window. This works in the same way as Windows Explorer and will use
the Recycle Bin if you have that Explorer option enabled.



OK Button
Commits changes and closes the window.



Cancel Button
Cancels the entire operation and closes the window.



Close Button
Closes the window.



Help Button
Displays this help page.



Apply Button
Applies changes to the image and closes the window.



Skip Button
Skips this image and closes the window.



Browse Button
This button brings up a folder browser which enables you to choose the target folder for the current 
operation.



Find Button
Begins the search for the specified pattern in all open browsers. If the Include Basket option is checked, 
the basket is also searched.



Target Folder
This is where you enter the target folder for the current operation. You can either type it in, or use the 
Browse Button to navigate to the required folder. If you enter a folder name that does not exist, the OK 
Button will change to Create Folder, which means that the folder will be created if you choose to 
continue. This control maintains a list of the most recently entered folder names. You can choose from 
this list by clicking on the drop-down arrow to the right of the control.



Target Image
This shows the thumbnail for the image that is the target of the current operation. You can double-click it 
to open the image for closer inspection.



Current Name
This shows the current name of the image.



New Name
Type the new name of the image here and click the Rename button to rename it.



 Open Target Image
This opens the image that is the target of the current operation.



Memo Text
Type the memo text here and press the Apply button to apply it to the image. To delete an existing memo,
delete any text from this box and apply the empty memo to the image.



Image Information
Shows various information about this image.



About General Preferences
Each option on this page affects the operation of the whole program and all browsers.



Ask before opening
This option is used by the Open command. If it is checked, the program will ask you to confirm whenever 
you try to open more than the number of images specified in the edit box to the right of this check box.



Open Image Threshold
This edit box specifies the maximum number of images that can be opened at the same time before the 
program asks you to confirm the operation. It is only used when the check box to its left is checked.



Ask before moving
If this option is checked, the program will ask you to confirm that you wish to move images to another 
folder following a drag and drop operation. If you do manage to accidently perform a move, you can undo
the operation from Explorer’s undo command.



Auto Re-Lay
If this option is checked, the program will automatically execute the Re-Lay Thumbnails command 
whenever the browser window is resized.



Auto Scroll
If this option is checked, the program will automatically scroll the thumbnail panel to ensure that newly 
created thumbnails are visible. If you find this behaviour distracting, you can disable it with this option. It 
is still possible to scroll up to view previously created thumbnails; the auto-scroll is temporarily disabled 
when you scroll up, and re-enabled when you return to the last position it was active at.



Show Tooltips
If this option is checked, the program will display tooltips. Otherwise tooltips will not be displayed.



Confirm Image File Deletion
If this option is checked, the program will display the Delete Confirmation Window whenever you attempt 
to delete one or more images. If you disable this option, you will be relying on your Explorer settings to 
protect you from accidental deletions. This option is also disabled if you check the Don’t show me this 
again option on the Delete Confirmation Window itself.



Label Thumbnails
If this option is checked, thumbnails will be labelled according to the format specifiers in the edit box. You
can click the example buttons to see some example formats.



Panel Colour
Click this button to change the colour of the thumbnail panel. The current colour is shown in the square to
the right of the button.



Selection Colour
Click this button to change the colour of selected thumbnails. The current colour is shown in the square 
to the right of the button.



About Folder Preferences
Each option on this page of the preferences window affects only the current folder. The name of the 
affected folder is displayed as the title of the group. By allowing each folder to have its own preferences, 
you can easily control the needs of different folders. For example, you may have a folder that contains 
hundreds of images. It might be wise to set the thumbnail size for this folder to be smaller than usual, in 
order to keep memory requirements to a minimum. Or you may have a folder with only a handful of 
images in it. In this case, you could create large high quality thumbnails since it won’t take long to load 
the browse file for such a small folder. Furthermore, some folders will probably contain different kinds of 
images, and you may want to sort them by different criteria.



Auto-Update
If this option is checked, the program will automatically execute the Update Thumbnails command 
whenever you open this folder in the future. This is handly for small folders that change often, but can 
become a nuisance if you have a large folder that hardly ever changes, because the program will waste 
time scanning it every time you open it. In the latter case you can disable auto-update with this option, 
and manually update the thumbnails whenever you want to.



Auto-Save
If this option is checked, the program will automatically save the browse file for this folder a few seconds 
after a change is made to the state of the thumbnails. In some circumstances it is possible to make a 
change to the thumbnails that does not result in an immediate auto-save (eg: sorting). In this case, the 
thumbnails are still auto-saved when you close the folder by navigating to a different folder, or when you 
close the program. Of course, it is still possible to save manually whenever the save command is 
available. If this option is not checked, the program only saves after asking you to confirm that you want 
to do so. This is useful for very large folders where frequent time-consuming auto-saves would drive the 
user crazy. Note that the program only saves the browse file when it took longer than a few seconds to 
create the thumbnails.



Display additional file types
If this option is checked, the program will display thumbnails for additional file types (specified in the 
nearby edit box), but will not be able to load the images. This enables you to organise other types of files 
even though they are not supported by the thumbnail loader.



Generate draft quality thumbnails
If this option is checked, the program will generate thumbnails by using a simple resizing procedure. This
is fast, but results in thumbnails that look jagged and grainy. This option can be used when you don’t 
care about thumbnail quality and just want to quickly see the contents of a folder. However, if you are 
planning to use the Thumbnail Wizard to generate a web page, you should first turn this option off and 
reload the thumbnails. It takes longer to create high quality thumbnails, because the images are 
resampled rather than simply resized, but the image quality is far better. Please don’t put draft quality 
thumbnails on your web page.



 Enable dithering
If this option is checked, it enables dithering to be used when drawing thumbnails on 256 colour displays.
Dithering is a method by which colours can be approximated on displays that do not support enough 
colours to show the correct ones. It gives better looking thumbnails but is much slower to draw. This 
option is unavailable (greyed out) when the program is running on high or true colour displays. The latter 
mode of operation is preferred, since 256 colour mode is slower and suffers from palette flickering 
problems. Note that this option only affects the way thumbnails are drawn - the files output by the 
Thumbnail Wizard are full 24-bit JPEG files.



Use Defaults
The effect of this button is to load the default folder preferences into the window. The default preferences 
for a folder are those that were last saved with the Set Defaults button. If the Set Defaults button has 
never been pressed, then the defaults used are those built into the program.



Set Defaults
The effect of this button is to save the current folder preferences as the default folder preferences. This 
means that whenever a new folder is opened in the future, these preferences will be used unless you 
manually change them.



Reset All Folders
This button can be used when you think you have completely messed up your folder preferences, and 
want to start all over again. It deletes all stored folder preferences and reverts to using the defaults. It 
should not be used lightly. It asks if you are sure before proceeding. After that, there’s no going back.



Thumbnail Size Edit Box
This edit box holds the thumbnail size. The thumbnail size is the size, in pixels, of the longest edge of the
thumbnail. You can set this to any value between 16 and 400. Alternatively, you can use the Drag 
Thumbnail Size Window to visually set the thumbnail size.



Thumbnail Size button
This button toggles the display of the Drag Thumbnail Size Window which is used to visually set the 
thumbnail size.



The Drag Thumbnail Size Window
This window can be displayed by clicking the Thumbnail Size button. It is used to visually set the 
thumbnail size. Simply drag a corner of the window until the picture inside it is of the desired size. This 
works together with the Thumbnail Size Edit Box; each updates the other.



Sorting options
These radio buttons control the type of sorting that is performed on the thumbnails. You can check the 
effect of any sort option by clicking it and then clicking Sort Now. The following sort options are available:

Option                                               Sort uses  
Image width The width of the image in pixels.
Image height The height of the image in pixels
Image depth The depth of the image in bits.
Image area The area of the image in pixels.
File name The name of the image file.
File extension The extension of the image file.
File date The date stamp of the image file.
File size The size, in bytes, of the image file.
Colour temperature The colour temperature of the image.
Average brightness The average brightness of the image.
Aspect ratio The aspect ratio of the image.
Do not perform sort No sorting is performed.



Sort direction
These radio buttons control the sort direction.



Sort Now Button
This button sorts the thumbnails immediately, without waiting for the user to close the preferences 
window. This is useful when testing the effect of the sorting options.



About JPEG Preferences
These options and settings affect everything to do with JPEG files in PMIO. This includes the quality of 
thumbnails on the Thumbnail Panel and the quality of thumbnails output by the Thumbnail Wizard.



Encoding method
These radio buttons allow you to choose between Standard and Progressive encoding. These options 
modify the way that JPEG files are stored, and therefore the way they behave when re-loaded. Standard 
encoding is the normal method, in which the image is loaded more-or-less sequentially. Progressive 
encoding can be used when you expect that the image will be loaded from a slow system, for example, a 
web page. It enables the loader to display the image in progressively increasing quality. The advantage 
of this is that the user gets to see a low-quality rendition of the image relatively quickly, and can decide 
whether to continue looking at this image before it is even finished loading. This option is recommended 
when creating thumbnails for use on a web page.



Compression and image quality
This controls the amount of compression that the program will use when creating JPEG files. Since the 
thumbnails are created as JPEGs, this affects their quality. You can use the slider to set the quality, or 
type a number between 0 and 100 into the edit box. The highest quality and largest files are obtained 
when you use a setting close to zero. The lowest quality and smallest files are obtained when you use a 
setting close to 100. You can adjust the quality and compare the two sample images to see how the 
setting affects the quality.



About Applications Preferences
This page allows you to edit the list of applications which appear in the Open With menus. For each 
application in the list you must provide a name and a program. The names are used as menu captions, 
and the programs are the full paths to the applications’ executable files (exe). A cell in the list can be 
edited by clicking once to select it, and again to open it for editing. The applications #Internal and 
#Registered are always present, and represent the Internal Viewer and the Registered Association 
respectively.



Internal Viewer
To open an image in the Internal Viewer, you can use the menu Open With / Internal Viewer command. 
This opens a new viewer window and loads the picture into it. The following commands are available 
from the context menu in the viewer (keyboard shortcuts are shown in parentheses):

Mirror (H) Flips the image horizontally.
Flip (V) Flips the image vertically.
Negate (N) Negates the image, like a photographic negative.
Monochrome (M) Converts the image to monochrome.
Reopen Reloads the image file.
Close (Alt+F4) Closes the viewer.

These commands do not affect the image permanently.

Note: To make Internal Viewer the default PMIO viewer, move it to the top of the application list. For 
more information on how to do this, see Preferences - Applications Tab.



Registered Association
The registered association for a file type is the application that is launched when you open the file in 
Windows Explorer. For example, if the registered association for .jpg files is set as C:\Viewer.exe 
then the program C:\Viewer.exe will be launched when you open the file Image.jpg in Explorer. By 
selecting the Open With / Registered Association command in PMIO, you make sure that the image is 
opened in your preferred application for that file type. These associations are set in Explorer by choosing 
the View / Options command and selecting the File Types tab.

Note: To make Registered Association the default PMIO viewer, move it to the top of the application list. 
For more information on how to do this, see Preferences - Applications Tab.



Add
This allows you to add a new application to the list. Use the open file dialog to choose the application 
program which will appear in the Program column. Then edit the corresponding application name in the 
Name column.



Modify
This allows you to modify an existing entry. If a name is selected, it will open the name so it can be 
edited. If a program is selected, it will display an open file dialog which you can use to choose a different 
application to use. The program entries #Internal and #Registered cannot be modified because they are 
required for the program to operate correctly, but you can change their name entries.



Remove
This allows you to remove an entry. The entries called #Internal and #Registered cannot be removed 
because they are required for the program to operate correctly.



Launch Now
This launches the selected application with a test picture so you can test that it works ok.



Move Up
This moves the selected application up in the list. The application at the top of the list is the one that will 
be used when you choose the standard Open command from any menu or toolbar.



Move Down
This moves the selected application down in the list. The application at the top of the list is the one that 
will be used when you choose the standard Open command from any menu or toolbar.



Name Column
This column contains the names of the applications. These names will appear in the Open With menus. 
You can use the & character before a letter to specify the shortcut for that menu option. For example, if 
you enter the name &Viewer then the menu item will appear as Viewer and you will be able to select 
that item by pressing Alt+V.



Program Column
This column contains the paths to each application’s executable file (exe). You can either type a file 
name straight into a program cell, or choose Modify to browse for one.



 About Thumbnails
A thumbnail is a small picture which represents an image file on disk. It typically shows a scaled down 
version of the image, but it can also just display textual information. When you first navigate to a folder, 
the program scans the folder and finds all image files that it recognises. It then creates a thumbnail for 
each image file, and begins to load the files and create scaled down versions of them. As each image is 
loaded, its thumbnail changes from a text-only display to the actual scaled down image. Various 
preferences affect the new thumbnails, for example thumbnail dimensions and quality. The dimensions 
refer to the size of the thumbnails. You can create thumbnails ranging in size from 16x16 pixels to 
400x400 pixels. Generally, it is a good idea to create smaller thumbnails when the folder has a lot of 
images in it, this keeps the memory usage and browse file size to a minimum. The thumbnail images are 
internally stored as JPEG data. This reduces the amount of memory required to store the images, and it 
also reduces the size of the browse file because the browse file is created from the JPEG data. Because 
of this, the JPEG quality preference affects thumbnail quality.



About Selections
When you want to perform an action on one or more images, you must first select them. All operations 
that can be performed on images affect only the selected images. Images can be selected by either 
selecting their thumbnails, or by selecting them in the basket. Making a selection works similarly to the 
Explorer. You can click to select just one item, hold down Ctrl to toggle selection, or hold down Shift to 
select a range of images. You can also change the selection by using the selection commands in the Edit
menu. If you click on the thumbnail panel (but not on a thumbnail) you can drag a ‘rubber band’ rectangle
around a set of thumbnails to select them. If you hold down Ctrl while doing this, you can add to the 
selection.



 Dragging Thumbnails
Selected thumbnails can be dragged to the Folder Browser or Shortcut List - this will move the images to 
the target folder. You can also drag the thumbnails to the thumbnail panel on another browser. You can 
arrange the thumbnails manually by dragging them within the same thumbnail panel. Doing this 
automatically assumes that you are sorting manually, and switches the sort preferences to ‘Do not 
perform sort’. Note that dragging thumbnails is disabled during loading and saving operations. This is 
because moving thumbnails around would upset the loading system.



About the Browse File
The Browse File is a ‘thumbnail cache’. This means that once you have spent time building the 
thumbnails for a particular folder, they are saved in a file so that next time you navigate to the same 
folder, you only have to wait for the browse file to be loaded, instead of all the individual images. Each 
folder has its own browse file preferences.



 About Image Memos
A Image Memo is a piece of text associated with an image. The memo text can be set for an image by 
selecting it and choosing the Properties command from the Image menu, tool bar or thumbnail context 
menu. Once a memo has been assigned to an image, a small icon ( ) will appear with the thumbnail for 
that image. Memos can be exported to a text file by choosing the Export Image Memos command from 
the File menu or tool bar. A memo can be deleted by simply deleting the text from the Properties Window.
Note that the memo is associated with the image file, not the thumbnail. This means that when image 
files are copied or moved within PMIO, the memo is also copied. By the same token, reloading the 
thumbnails or deleting the browse file does not affect the memos. The actual text is stored in a separate 
folder inside the PMIO folder and is referenced by an entry in the system registry.



How to create a new shortcut
Shortcuts can be created in two ways. The first way is to navigate to the folder for which you wish to 
create the shortcut, and then choose the Add To Shortcuts command from the Folder Browser’s context
menu. The second way is to invoke the context menu on the Shortcut List itself, and choose the New 
Shortcut… command. This brings up a dialog box in which you can specify the target folder for the 
shortcut. Note that typing a non-existent folder name here gives you the opportunity to create the folder 
and the shortcut to it at the same time.



External Operations
If you perform operations on image files externally to PMIO, for example by using Explorer, then you 
must ensure that PMIO is informed of the changes. Otherwise it will get ‘out of synch with reality’. You 
can do this by using the Update Thumbnails command. Generally however, performing operations 
outside of PMIO while it is running is discouraged.



About Docking Toolbars
The toolbars can be detached and moved around (floating) or they can be docked to the top edge of the 
browser. To detach a docked toolbar, click and drag the left edge of it. To dock a floating toolbar, click on 
its caption and drag it to the top of the browser, until the drag-rectangle snaps into place. Then release it.



About Tooltips
A tooltip is a small window containing text. Tooltips usually appear when you hold the mouse cursor over 
a toolbar button, and in PMIO they also appear when you hold the mouse cursor over a thumbnail. In this
case, the tooltip gives information about the image that the thumbnail represents.



 About Shortcuts
A shortcut is a quick way of accessing a folder. Shortcuts appear in the Shortcut List which is empty 
when you run PMIO for the first time. One of the first things you should do when you start using PMIO is 
set up some shortcuts to your most frequently used image folders. This will make it a lot easier to copy 
and move images because these shortcuts to your favourite folders are always accessible regardless of 
the state of the Folder Browser. The same list of shortcuts is used throughout the program, and all 
browsers will display the same ones. You can drag thumbnails from the thumbnail panel to a shortcut and
have the images moved to the corresponding folder instead of having to navigate the folder browser to 
find the target folder. You can double-click a shortcut to automatically navigate to that folder and open it 
in the thumbnail panel. You can delete a shortcut by selecting it in the Shortcut List and pressing the 
delete key on the keyboard. You can rename a shortcut by selecting it and then clicking on the text, the 
same as renaming files in Explorer.



About Context Menus
A context menu is a pop-up menu that appears when you press the secondary mouse button (this is 
usually the right button). The contents of this menu depends on the object under the mouse cursor, and it
allows you to perform some action on that object. This is a standard fitting in Win32 applications. Pink 
Mouse suggests the following course of action when you are unsure of how to proceed… “If in doubt, 
right-click on it!”.



 
 About Colour Temperature

Colour temperature is a term describing the overall tint of an image. The name is derived from the 
processes involved when an object is heated. If you heat up an iron bar, first it glows red, then white, and
finally blue-white. The temperature of the iron determines its colour (the same reasoning applies to 
stars). In PMIO, if you have an image with an overall red tint, it is said to have a lower colour temperature
than an image with an overall blue tint. The effect of sorting by colour temperature is to place all the 
reddish images first, followed by neutral images, and finally bluish images. This can be very useful when 
you are organising images that all came from the same photo shoot, under the same lighting conditions. 
You can use this sort option to quickly group most of the similar coloured images, and then manually 
drag the remaining ones into position. Note that it only works on the red to blue scale… green and other 
tints are not relevant.



 
 About Average Brightness

The average brightness of an image is found by adding up the brightness of each pixel, and dividing by 
the number of pixels. The effect of sorting by average brightness is to place all the darker images first, 
and all the brightest images last. This can be useful when organising images from photo-shoots in 
different lighting conditions. It can also be used when you want to delete all the images that are too dark 
or too bright; it is easier to delete them when they are all next to each other in the thumbnail panel.



 
 About Aspect Ratio

The aspect ratio of an image is the relationship between its two dimensions, expressed as width divided 
by height. The effect of sorting by aspect ratio is to place all the narrow images first, and the wide images
last. This can be useful when organising images from different sources, as it groups together all the 
images of a similar shape.



About the JPEG file format
JPEG stands for ‘Joint Photographic Experts Group’ and refers to a group of people who have developed
one of the most ingenious graphics file formats. PMIO uses the JPEG file format internally for storing its 
thumbnails, in an attempt to reduce the memory usage and browse file size. Because of JPEG’s 
incredible compression ratios, it is possible to generate 24-bit browse files that are smaller than an 
uncompressed 8-bit file would be. The limitation of JPEG is that it only works well for photographic 
images, and is not very good for line-art or other solid graphics with few colours. PMIO uses the IJG 
Library of JPEG functions, in other words, this software is based in part on the work of the 
Independent JPEG Group.



    About Pink Mouse Productions
Pink Mouse Productions is the name of a non-existent company which is commited to producing high 
quality free software. In reality, the author is writing this software in his spare time. You can find more 
information at this web site:

http://ourworld.compuserve.com/homepages/sprucetree/



File Menu
The File Menu contains the following file-related commands:

Open Folder
Close Browser
Save Browse File
Delete Browse File
Thumbnail Wizard
Export Image Memos
Close All and Exit



Edit Menu
The Edit Menu contains the following editing commands:

Cut
Copy
Paste
Find…
Select All
Select None
Invert Selection



Image Menu
The Image Menu contains the following image-related commands:

Open…
Open With
Delete…
Rename…
Copy To…
Move To…
Load Now
Add To Basket
Set As Wallpaper
Animate Selection
Ping-Pong Selection
Properties



View Menu
The View Menu contains the following display-related commands:

New Browser
Basket Window
Animation Window
Update Thumbnails
Re-Lay Thumbnails
Reload Thumbnails
Show As Image
Show As Text
Show Toolbar 1
Show Toolbar 2
Preferences



Help Menu
The Help Menu contains the following help-related commands:

Contents
About…
System Info…






